
 



 
 

Alustamine  
logger Pro nõudmised  
Kasutamaks Logger Pro, peate omama Windows või Macintosh op 
süsteemiga arvutit. Süsteeminõudeid saate vaadata 
www.vernier.com/lp. Andmete kogumiseks vajate allikat kas 
LabQuest, LabPro või Go!Link koos Vernier sensoritega, Go!Motion 
või Go!Temp. Teised sobivad sisendandmed on kirjeldatud 
www.vernier.com/lp  

.  

logger Pro 
Laadimine Windowsis  
• Asetage Logger Pro CD teie arvuti CD-ROM drive .  

• Kui Autorun on lubatud, algab installeerimine automaatselt 
vastasel juhul valige Setup.exe mis asub CD - l.  

• Logger Pro installer alustab ning ekraanile ilmuvad mitmed 
dialoogi boksid, mis juhatavad teid läbi Logger Pro tarkvara 
installeerimise.  

 

Macintosh  

• Asetage Logger Pro CD teie arvuti CD-ROM drive  ja tehke 
topeltklikk CD ikoonil.  

• Tehke topeltklikk “Install Logger Pro” ikoonil ning järgige 
juhiseid.  

  Vernier labQuest andmekoguja:  

Vernier LabQuest ühendatakse arvutiga USB 
kaabli vahendusel.  

Go!Link ühendub arvutiga USB kaabli vahendusel  

Go!link andmekoguja:  

Vernier LabPro ühendatakse arvutiga USB kaabli 
vahendusel  

Vernier labPro andmekoguja:  

Ettevalmistus 
Andmete kogumiseks Logger Pro jaoks vajate LabPro

®

 või 
Go!

®

Link, koos vähemalt ühe sensoriga.  

 

 

 

  

 



 

Initsialiseerimine   

Detailne abi on Logger Pro 3 Help failis. 

Enne Logger Pro käivitamist: 

• Ühendage LabQuest või muu 
andmekoguja toide.  

•  Ühendage sensor andmekogujaga.  

• Ühendage andmekoguja USB juhtme 
vahendusel arvuitga 

.  

 

 

 

logger Pro käivitamine 
Leidke Logger Pro ikoon  ja tehke topeltklikk sellel.  

Mac OS X kasutajad leiavad Logger Pro  kausta 
Applications all.  

Logger Pro võib koguda andmeid mitmest allikast. Kui Logger 
Pro on leidnud allika siis ilmub ekraanil selle allika ikoon. Kui 
auto-ID toega sensor on ühendatud, näete selle sensori hetke 
lugemit ekraanil. Mõned allikad ei toeta auto-ID (WDSS, GPS 
või Ohaus kaalud), need ühendatakse käsitsi. Valige 
Experiment menüüst Connect Interface�(allika nimetus) valik 
connect.  

Pildil on arvutiga ühendatud Go!Link, Go!Temp, LabPro 
ja Ohaus kaalud.  

Olete edukalt installeerinud ning ühendanud allika. Edasi 
kirjeldame erinevaid andmete kogumise ja kasutamise 
võimalusi.  



 
Sissejuhatus  

Logger Pro on andmete kogumise ja analüüsi programm mis 
töötab koos Vernier LabQuest, LabPro, Go! Link, Go!Temp, Go! 
Motion, Vernier/Ocean Optics Spectrometers, Vernier WDSS ja 
Ohaus kaaludega. Andmeid saab sisestada ka käsitsi, kopeerida 
lõikelaualt, tuua sisse failina:  

• Andmete analüüs, statistika, sirge tõusud, arvutatud tulbad.  

• Piltide lisamine.  

• Videode lisamine ja nende sidumine mõõteandmetega.  

• Käsitsi andmete sisestamine.  

•  Eksportimine programmi Excel
®

.  

• Joonistada eeldatavaid graafikuid ning eksperimendi 
tulemusena kontrollida nende sobivust. 

� Videot saab sisestada digi või veebikaamerast.  

Help guide jagab lisaõpetust Logger Pro programmi kohta.. 

 



 
 

Juhendid 
Juhendid leiate valides File menüüst Open:  

•  Alustamine, Liikumise mõõtmine  

• Statistika, Tangents, Integraalid (osa 1 ja 2)  

•  „Events with Entry“, Andmete sisestamine käsitsi,  

•  Sirge leidmine, Videoanalüüs 

 The extensive Help in logger Pro provides detailed instructions for 
use of the program. The answer you are looking for may be just a 
mouse click or two away!  

Andmete kogumine 
Andmeid saab sisestada andmekogujast, käsitsi ning ühilduvast 
seadmest.  

  

logger Pro ettevalmistamine 

teostatavaks eksperimendiks 

Enamus seadeid rakenduvad automaatselt 

 � Auto-ID Sensorid ühendatakse andmekogujaga ning 
käivitatakse Logger Pro. Sensor tuntakse ära automaatselt ning 
laetakse vaikimisi andmekogumise seaded antud sensori jaoks. 
Vajutage nuppu 
 

 ning alustage andmete kogumist!  
Sensorite puhul, millel pole auto-ID, avage 
valik Probes & Sensors. Valige File menüüst 
Open ja edasi Probes & Sensor. Sealt leiate 
iga Vernier sensori. Avage ühendatud sensori 
aken. 



 

 

• Vernier katsete raamatute failid Kui valite File menüüst Open 
näete katsete raamatute näiteks Biology with Computers jne. Igaühes neist 
on 30-40 eksperimendifaili mis vastavad eksperimendile katseraamatus.  

• � Sensor dialoog Klikkides nupul  

 näete infot sensori kohta, ühikuid ning hetke lugemit. Kui auto-
ID sensor on ühendatud, tunneb Logger Pro selle automaatselt ära, 
kui aga auto-ID puudub, saate kasutatava sensori lohistada vastava 
kanali aknasse.  

  

. Kui teil on vaja koguda andmeid kauem, valige Experiment 
menüüst Extend Collection.  

. Logger Pro alustab andmete kogumist ning graafiku 
joonistamist. Tavaliselt lõppeb andmete kogumine kui x telg 
on täitunud. Saate ka lõpetada nadmete kogumise varem, 
vajutades  

 

Andmete kogumiseks valmis 

Vajutage  



Andmete säilitamine 

Experiment menüüs asuv Store Latest Run võimaldab salvestada 
mõõtmise ja alustada uut ilma vana kaotamata.  

Viimane “Latest” mõõtmine sisaldab viimati kogutud andmeid ning 
kirjutatakse üle kui alustate uut andmete kogumist. Kui salvestate 
viimase mõõtmise, luuakse uus andmete kogum - Run 1, Run 2 jne. 
Viimased andmed on esitatud tulpades rasvase kirjaga. 

Note: Kasutades Store Latest Run, ei toimu andmete salvestamist 

kettale vaid vahemällu. Kui soovite salvestada kettale, valige Save As. 

Andmete kogumise moodused 

Põhiline andmete kogumise moodus on ajateljel baseeruv time-
based. Eksperimendi parameetrite muutmiseks valige Experiment 
menüüst Data Collection. Time Based andmed on aja funktsioon.  

 

Events With Entry Andmed salvestatakse kui vajutada Keep 
nuppu.  

Selected Events Andmed salvestatakse kui vajutada Keep nuppu. 

Digital Events Andmed kogutakse kuni stopp nupu vajutuseni 
või kuni kindel arv sündmusi on toimunud.  



 
 

Andmete sisestamine käsitsi 
Andmeid võib sisestada käsitsi. 
Selleks ühendage andmekoguja lahti 
ning käivitage Logger Pro. Vajutage 
lahtril ning trükkige sinna number. 
Sisestatud andmed joonistatakse ka 
graafikule.  

 

Andmete import 
Andmeid on võimalik importida LabQuestist. Peale andmete kogumist 
LabQuestiga, ühendage see arvuitga ning käivitage Logger Pro.Järgige 
dialoogmenüüd ekraanil.  

 

 

  
  



 



 

 Ikoonid  

kliki  kirjeldus  kliki  kirjeldus  

 
Loo dokument.  

 

 
Tangets.  

 
Ava dokument.  

 

 
integreerimine.  

 

 
Salvesta dokument.  

 

 
Statistika arvutamine.  

 

 
prindi.  

 

 
Lineaarne sobitus.  

 

 
Sirvi lehekülgi.  

 

 Lähima sobiva joone leidmine.  

 

 
Hetkel kuvatava dokumendi eelmine lehekülg.  

 

 
Andmete kogumise parameetrid.  

 

 
Hetkel kuvatava dokumenti järgmine lehekülg.  

 

 
Alusta andmete kogumist.  

 

 
Ava andmeaken.  Järgnevad ikoonid ilmuvad, kui alustate andmekogumist  

 

 
Andmete sisestamine TI kalkulaatorilt.  

 

 
Seiska andmete kogumine.  

 

 
Automaatne skaleerimine.  

 

 
EKG indikaator.  



Logger Pro sisust 

.  

logger Pro ekraan ja tööriistariba 
Tööriistariba Asuvad põhilised Logger Pro nupud. Need on 
esindatud ka menüüdes. Hiire viimisel nupule avaneb selle toime 
lühikirjeldus. 

Menüüriba Ligipääs tarkvara võimalustele.  

 

Objekt Saate lisada objekte Insert menüüst ja modifitseerida neid 
kasutades Options menüüd. Mõned objektid:  

Graph Cartesiuse graafikud, Histogrammid, FFT Graafikud.  

Table Andmetabel.  

Text tekstiredaktor.  

Text Annotation tekst andmete kohta seoses graafikuga.  

Meter Kuvab tulba andmed suures kirjas, termomeeter, mõõdik, 
või animeeritud ekraan.  

Movie video lisamine eksperimenti, andmete sünkroniseerimine 
videoga.  

Picture pildi lisamine.  

Navigeerimine lehekülgede vahel 

Logger Pro 3 programmis on „leheküljed“. Võimaldab hoida erinevad 
andmeid samas failis. Ühel lehel võib olla graafik ja tabel kuni viie 
erineva andmekogumiga.  

Click   
  Järgmisele lehele 

 Eelmisele lehele.  

 Otse liikumine lehekülgede vahel.  



 
 

Sensori aken 

 
Vajutades 

Kerimisnuppu kasutades näete kogu sensorite valikut.  

Vajutades Channel box millele on ühendatud sensor, saate:  

• Calibrate a sensor kalibreerida.  

• Get sensor information detailsey infot.  

• Zero a sensor nullida.  

• Choose sensor valida sensorit.  

• Change the current settings vahetada mõõtühikuid või 
kalibratsioone 

• Analog out (CH 4 only) kasutada funktsioonigeneraatorina.  

• Remove sensor eemaldada sensorit.  

 nupule ilmub ekraanile kasutatav andmekoguja koos 
kasutuses olevate sensoritega, mõõtühikud ning lugem.  Resize Objects valimiseks üks klikk. Objekti 

suuruse seadmine venitamise või surumisega.  

Move Objects valimiseks üks klikk objektil. Liigutage korsorit üle 
objekti kuni see muutub käeks, vajutage hiire nupp alla ja liigutage objekti.  

.  

Andmed ja lehekülg 
Andmete kuvamise erinevad võimalused.  

Toimingud objektiga 



 
 

Graph Axes kuvatava graafiku muutmine.  

1. Asetage kursor X- või Y-telje nimetusele ja klikake.  

2. Valige tulp, mille andmeid soovite graafikul kuvada. Kui soovite 
kuvada rohkem kui üht tulpa, valige More ning vajalike andmetega 
tulp.  

 

Graph Options topelt klikk 
graafikul või valige Graph Options 
Options menüüst. Võimaldab muuta 
graafiku kuvamise seadeid. Klikka 
Axis Options Tab, et seada skaalat 
ning graadikul kuvatavaid tulpi.  

Tulba loomine 

Andmete käsitsi sisestamiseks võite luua 
tulba või luua tulba tuginedes eelmiste tulpade andmetele. Valige New 
Manual Column või New Calculated Column menüüst Data.  

Lahtrite redigeerimine 

Käsitsi sisestatud andmeid ning Events with Entry mooduses 
kogutud andmeid on võimalik redigeerida.  

•  Klikates lahtril, saate seda redigeerida.  

• Lahtri valimiseks klikake sellel ning valadusel lohistage 
üle selle kõrval olevate lahtrite.  

• Klikates tulba päises saate valida kogu tulpa.  

• Rea numbril klikates valite terve rea.  

  

 

  

Data Browser 

Andmebrauser kuvab kõik failis 
sisalduvaid  andmed.  

 



 
 

 

analyze Data  
The Analyze menu contains functions for examining and 
analyzing your data. A few of the most commonly used analysis 
functions include:  

• Examine Shows the x- and y-values of the data point 
closest to the mouse pointer.  

• Statistics Calculates the minimum, maximum, mean, and 
standard deviation.  

• Curve Fit Fits a selected or user-defined function over 
the data.  

• Draw Prediction Sketch a prediction on a graph using 
the mouse.  

Several of the analysis features are available from the 
Toolbar.  

additional analysis features  

Movie You can synchronize data collection and a movie of the 
experiment so that as you Replay the movie, the data are replayed 
on the graph.  

Video Analysis You can create a graphical representation 
of the motion you see in a movie.  

Model Perform a manual curve fit of your data.  

Histogram Displays the distribution of values for a data set in bar 
graph format.  

Strip Chart Each new collected data point gets added to the 
right most edge of the graph.  



 

 

Set Preferences  

The Preferences dialog box contains several options that pertain to the 
general operation of the software. These preferences will apply every 
time Logger Pro is launched.  

In Windows, choose Preferences from the File menu. In Mac OS 
X, choose Preferences from the Logger Pro menu.  

Printing  
Print Graphs and Data  

1.   Arrange the objects on the screen as you want them to appear 
on the paper. If you choose, you can print several graphs and 
data tables at once.  

You can print the graphs and data tables individually by 
selecting Print Graph or Print Data Table from the File menu. 

Where to next?  
The extensive Help system in Logger Pro provides detailed 
instructions for these and other features.  

Also available are the Logger Pro Tutorials. Choose Open from 
the File menu to access them. These short tutorials are suitable for 
reference or for use in your classes. First-time users should work 
through one introductory tutorial and the advanced tutorials as 
needed.  

If you have questions as you are using our software, call or e-mail 
us. We will be happy to help!  

 

 Ikoonid  

kliki  kirjeldus  kliki  

 
Loo dokument.  

 

 


